Legal Notices

Warranty
The only warranties for Hewlett Packard Enterprise Development LP products and services are set forth in the express warranty statements accompanying such products and services. Nothing herein should be construed as constituting an additional warranty. HPE shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend
Confidential computer software. Valid license from HPE required for possession, use or copying. Consistent with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard commercial license.

Copyright Notice
© Copyright 2017-2019 Hewlett Packard Enterprise Development LP

Privacy Policy

Trademark Notices
Microsoft® and Windows® are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.

UNIX® is a registered trademark of The Open Group.

Linux® is the registered trademark of Linus Torvalds in the U.S. and other countries.

Red Hat® is a registered trademark of Red Hat, Inc. in the United States and other countries.

© 2012 Google Inc. All rights reserved. Chrome™ is a trademark of Google Inc.
Contents

Overview .................................................................................................................................................. 6

My IT Environment ................................................................................................................................. 7
  Register devices ..................................................................................................................................... 8
  Complete direct connect device registration ...................................................................................... 8
  Edit service information ....................................................................................................................... 11
  Manage your user groups ..................................................................................................................... 14
  Create a user group ............................................................................................................................. 14
  Assign roles to user groups .................................................................................................................. 17
  Roles apply equally to all users of a user group ................................................................................... 18
  Your default user group ....................................................................................................................... 19
  Delete a user group .............................................................................................................................. 19

Manage your devices, device groups and solutions ............................................................................. 20
  The All devices view ............................................................................................................................ 21
  Types of objects displayed .................................................................................................................. 21

Devices ...................................................................................................................................................... 22
  Device states ......................................................................................................................................... 23
  Icons and text in individual devices ..................................................................................................... 23
  Delete a device ....................................................................................................................................... 25
  Refresh devices ...................................................................................................................................... 25
  Add a device manually .......................................................................................................................... 25
  Devices with expired contracts or warranties ...................................................................................... 26
  Claim an HPE storage device ................................................................................................................ 27

Device groups .......................................................................................................................................... 27
  Your default device group ..................................................................................................................... 28
  Create a device group ........................................................................................................................... 30
  Device group roles ................................................................................................................................ 32
  Delete a device group ........................................................................................................................... 33

Solutions .................................................................................................................................................. 34
  Solution as container ............................................................................................................................. 34
  Solution as device ................................................................................................................................ 36

Contracts and warranties ....................................................................................................................... 38
  Link contracts and warranties .............................................................................................................. 38
    Link support agreements ..................................................................................................................... 38
    Link packaged support ......................................................................................................................... 39
    Link warranties ..................................................................................................................................... 40
  Batch link tool ......................................................................................................................................... 42
    CSV file field values ............................................................................................................................ 43
  Derived contracts and warranties ........................................................................................................ 44
  Share contracts and warranties ............................................................................................................ 45
  Create a contract and warranty share .................................................................................................... 46
Overview

Hewlett Packard Enterprise Support Center (www.hpe.com/support/hpesc) is home to Insight Online. Through Insight Online you and HPE Authorized Channel Partners have web access to feature services such as:

- **Devices**, which provides the ability to organize and monitor your devices. Devices are remotely supported or manually added.
- **Service events**, generated and reported to HPE by remotely supported devices.
- **Support Cases** associated with your HPE Passport ID.
- **Contracts and warranties** associated with your HPE Passport ID, or shared with you by other users.
- **Service credits**, which allows you to view Proactive Service Credits you have purchased, and services exchanged and available for those credits.
My IT Environment

Customers can view and manage their devices by using the Insight Online My IT Environment tab. The dashboard displays overview information for devices, service events, cases, and contracts and warranties.

**Note:** When using Insight Online, each HPE Passport ID can support a maximum of 1,500 devices.

You can reach My IT Environment in the following ways:

- **Option 1:** main menu > My IT Environment.
- **Option 2:** On the HPE Support Center homepage, click My IT Dashboard.
- **Option 3:** If you are already in Insight Online and want to return to the dashboard, click the My IT Environment tab.

From the My IT environment, you can:

- "Register devices" on page 8
- Manage your devices
- "Manage your user groups" on page 14
- Manage contracts and warranties
- View reports
- View your message log

In addition you can access:

- "Support cases" on page 57
- "Service events" on page 61
- "Service Credits" on page 53
- "My document repository" on page 64
Register devices

Successful registration of devices assumes the following:

- For central connect devices via Insight Remote Support (RS), you have correctly installed and configured Insight RS, entered your HPE Passport credentials to register for Insight Online, and specified your HPE Authorized Channel Partners in the Hosting Device Setup Wizard.

  **Note:** When using Insight Online, each HPE Passport ID can support a maximum of 1,500 devices. Make sure the sum total of monitored devices does not exceed 1,500 devices, even when the HPE Passport ID is used across multiple Insight RS clients. Additionally, during unusually large demands on Insight Online, you may see performance lags with HPE Passport IDs that support more than 1,200 devices across multiple Insight RS clients.

- For central connect devices via OneView Remote Support, you have correctly configured Remote Support within OneView, entered your HPE Passport credentials to register for Insight Online, and specified your HPE Authorized Channel Partners in OneView Remote Support.

- For direct connect devices, you have registered using the iLO or OA interface, and completed the registration process in Insight Online. The registration process in Insight Online includes specifying HPE Authorized Channel Partners.

  Another user in your company may have completed this registration process, and shared the contract and warranties or devices with you. In that case you will see the devices.

  For detailed information about setting up ProLiant Gen8/Gen9 servers and BladeSystem c-Class enclosures, see the HPE Insight Remote Support and Insight Online Setup Guide for HPE ProLiant Servers and HPE BladeSystem c-Class Enclosures at www.hpe.com/info/insightremotesupport/docs.

  For detailed information about setting up ProLiant Gen10 servers, see the iLO 5 User Guide at www.hpe.com/support/ilo-docs.

If the above steps have been completed, devices registered using:

- The central connect method are visible without any action on your part.

- The direct connect method requires you to complete their registration as described below:

**Complete direct connect device registration**

1. Sign in.
2. Select the **Insight Online My IT Environment** tab.
3. Click **Devices with incomplete registration**.
4. The **Complete device registration** page appears. Select one or more devices, then click **Next**. You can complete registration for multiple devices at one time if they share site, contact, and channel partner information.

5. Enter site and support information, then click **Next**. The **Provide HPE Authorized Channel Partner information** page appears:

6. Do one of the following:
   - If your support provider is HPE, accept the default settings.
   - If your support provider is an HPE Authorized Channel Partner, enter the partner location ID. Click **Check ID** to verify that the correct partner is selected.

7. Choose **Optimize my IT environment** setting. Note that for direct connect devices this action only applies to the specific devices you select.
By checking the box labeled **I consent to having HPE or my HPE Authorized Reseller/Distributor contact me to discuss optimizing my IT environment** you agree to allow HPE or your HPE Authorized Reseller/Distributor to access your collected configuration information and contact you with recommendations to purchase additional hardware and software products to optimize your IT environment. These providers may be located in other countries than your HPE IT hardware location(s). HPE Authorized Resellers/Distributors are required to keep information received from HPE confidential and may use it only for the purpose of providing advisories and recommendations on behalf of HPE.

To withdraw your consent, clear the box labeled **I consent to having HPE or my HPE Authorized Reseller/Distributor contact me to discuss optimizing my IT environment**.

**Note:** Only the HPE Authorized Resellers/Distributors and Authorized Service Partners you associate with your devices can receive your configuration data to individually contact you to make IT environment recommendations, sell or deliver solutions.

This setting can be updated at any time. See *Edit service information* on the next page.

8. Click **Next**. The **Validate and submit** page appears.

9. Click **Complete registration**.

If you select more than 15 devices:

- The registration is submitted by a batch process, whose name is "DC_REG" plus the timestamp in Coordinated Universal Time (UTC). For example:
  
  `DC_REG 2013-10-30 12:39:59:999 UTC`

- You are prompted to continue and to optionally provide an email address to receive a notification that the batch process has begun, and a notification when it has completed. Use the batch process name to look up the status of the process in your "Message log" on page 51.

- Devices in the list are grayed out if you do not have administrative privilege to modify them, or if they are part of a current batch process submitted by you or another user. When you receive the email saying the batch process is complete, you can click on the refresh devices button to remove the devices included in your batch process from the list, and to update the count of unregistered devices on the dashboard.

  The email notifications contain summary status information and a link to your message log which contains more details.

If you select 15 or fewer devices:

- The submission occurs interactively and the result appears on the next page with status about registration and about contract and warranty linking.

When you complete registration, if you provided partner information and selected to have your IT environment optimized, the partner will be able to view and manage your devices from the **My Customers** tab. For more information, see HPE Authorized Channel Partners.
You can change the partner information, contact information, and the optimize my IT environment selection for direct connect devices at any time:

- By group. See Edit service information.
- By individual device. Click on the device, and in the Configuration area of the Overview tab, click on the Edit links in the Partners and Support contacts sections:

  ![Edit service information](image)

Primary and secondary support contacts must be different.

**Edit service information**

Once you have completed registration of direct connect devices, you can edit the devices' site, support contact and partner information as a group.

To reach the page, browse to the My IT Environment homepage, either from the main menu or the HPE Support Center homepage. Then:
Option 1: On the My IT Environment page, click My IT Environment > Dashboard > Edit service information.

Option 2: On the My IT Environment page, click My IT Environment > Devices > Edit service information.

Then complete the following steps:

1. Select groups from Select device groups and click Next. The list shows only device groups that contain direct connect devices that you have administrative privileges to modify:

   ![Edit service information](image)

   **Step 1: Select groups**
   
   Use this process to edit service information for selected Insight Remote Support Direct Connect devices. Only groups that you have access to and which contain Direct Connect devices you have administrative privileges for will be shown. All edits will be processed offline and you may choose to be notified by email.

   1 - 14 of 14 items

<table>
<thead>
<tr>
<th>Select</th>
<th>Group name</th>
<th>Group description</th>
</tr>
</thead>
<tbody>
<tr>
<td>□</td>
<td>dc_user2 Devices</td>
<td>Created by the system to manage devices.</td>
</tr>
<tr>
<td>□</td>
<td>dc_user2 Devices - updated 20-08</td>
<td></td>
</tr>
</tbody>
</table>

2. Select target devices whose information you want to change and click Next. Only direct connect devices that you have administrative privileges to modify are listed.

3. Edit service information. Edit site, primary and secondary service information and support contact information.

   Primary and secondary support contacts must be different.

   Select an HPE Authorized Channel partner. You can select HPE or if you select a different partner, provide that partner's location ID.

   Choose Optimize my IT environment setting.

   **Note:** If you choose to have a channel partner manage your devices, select this option to allow the partner to see configuration details for the devices. See Enabling access to customer's device information for details.

By checking the box labeled I consent to having HPE or my HPE Authorized Reseller/Distributor contact me to discuss optimizing my IT environment you agree to allow HPE or your HPE Authorized Reseller/Distributor to access your collected configuration information and contact you with recommendations to purchase additional hardware and software products to optimize your IT environment. These providers may be located in other countries than your HPE IT hardware location(s). HPE Authorized Resellers/Distributors are required to keep information received from HPE confidential and may use it only for the purpose of providing advisories and recommendations on behalf of HPE.

To withdraw your consent, clear the box labeled I consent to having HPE or my HPE Authorized Reseller/Distributor contact me to discuss optimizing my IT environment.

**Note:** Only the HPE Authorized Resellers/Distributors and Authorized Service Partners you associate with...
your devices can receive your configuration data to individually contact you to make IT environment recommendations, sell or deliver solutions.

4. **Validate and submit** the new information.

The changes are applied to all the devices you selected. Changes are submitted by a batch process. The name of the batch process is "DC_EDIT" plus the timestamp in Coordinated Universal Time (UTC). For example:

```
DC_EDIT 2013-10-30 12:39:59:999 UTC
```

You are prompted to continue and to provide an optional email address to receive a notification when the batch process has completed.

Devices included in a batch process submitted by you or by another user remain in the device list but are grayed out. When you receive the email notification that your batch process is complete, you can click on the refresh devices button (Refresh devices) to return the devices included in that process to their normal state.

The email notifications contain summary status information and a link to your message log. Use the batch process name to look up the status of the process in the message log.

For central connect devices, you must change this information in the Insight RS Hosting Device user interface.
Manage your user groups

You create user groups for the purpose of assigning certain roles to users, for:

- Device groups
- Contract and warranty shares

A role is a permission granted to the user group to access services such as patch management or Service Credits. Roles are assigned in the final step of the process of creating a device group or a contract and warranty share (referred to as a "share" below).

Create a user group

You can create a user group at any time:

You can also create a user group when you need it, during the process of creating a device group or a share:
To create a user group, first provide a name and description:

**Unnamed user group**

1 User

**Required** *

**Group name** *

(Maximum length = 60 characters)

**Description**

(Maximum length = 255 characters)

Add members and administrators, and submit:
You do not have to create a new user group for each device group or share. User groups have a many-to-many relationship with device groups and shares:

- A device group or share can have many user groups associated with it.
- A user group can be associated with many device groups and shares.

The roles enabled for each association are distinct. However, for some roles such as Software updates or Patch, as long as the role is enabled for you from one device group or share, you have access to that service.

**Note:** After adding new users to an existing user group, you may need to run the contracts and warranties update in order for the new users to obtain the privileges associated with the user group. See [Run contract and warranty update](#) for details.

Users in a user group are administrators or members. You are an administrator of any user group you create. User group administrators can perform these actions:

- Add and remove user group members
- Assign user group admin privilege to a member
- Delete the user group
Assign roles to user groups

When creating a device group or a share, the final step is to assign roles to each user group. Select the check boxes to assign the roles:

If you want to assign different roles to different groups of users, use a separate user group for each role.

Role names and descriptions are grayed out if there is no contract or warranty associated with the device group or share that enables them. You can still check a role that is grayed out. This allows you to set the user group up with the roles it needs ahead of time. Adding a contract or warranty at a later time that covers the role will activate a grayed-out role that you have checked.

Roles for device groups and shares are as follows:

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device group administrator and member</td>
<td>See &quot;Device group administrator and member actions&quot; on page 32 for details.</td>
</tr>
<tr>
<td>Service Credits administrator*</td>
<td>Can redeem credits for services, schedule, reschedule, cancel services, receive notifications of scheduled or expiring credits.</td>
</tr>
<tr>
<td>Service Credits member*</td>
<td>Can view: Service Credits, HPE Services exchanged for those credits, HPE services available for exchange of those credits.</td>
</tr>
</tbody>
</table>
### Role

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Patch management*</td>
<td>Can access the patch management page, and patches for operating systems.</td>
</tr>
<tr>
<td>Diagnostic passwords*</td>
<td>Get passwords for HPE support tools for certain products.</td>
</tr>
<tr>
<td>Software updates and licensing*</td>
<td>Populates the list of SAIDs in the drop-down list at the initial page of the Software updates and licensing site (following the link on the HPE Support Center Product Support page).</td>
</tr>
</tbody>
</table>

* If a share, enabled directly by a contract in the share. If a device group, enabled indirectly by a contract associated with a device in the device group.

### Roles apply equally to all users of a user group

If you assign a new or existing user group to the device group or share you are creating, the roles you assign to the user group apply equally to every user in the user group.

You are assigning roles to the group as a whole—it does not matter whether any given user is an administrator or a member of the user group itself.

In the table below for example, two user groups are created for a device group. One of the user groups is assigned the role of device group administrator and the other the role of device group member.

Note that Francis Lee, though only a member of the user group, becomes an administrator of the device group. Similarly Pradesh Jones and Akiko Yamada, though administrators of the user group, become members of the device group.

### Roles are assigned group-wide

<table>
<thead>
<tr>
<th>User groups and users</th>
<th>User group privilege</th>
<th>Assign this device group role to the user group</th>
<th>Device group role</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Paris device group admins&quot;</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Marie Curie</td>
<td>admin</td>
<td></td>
<td>admin</td>
</tr>
<tr>
<td>- Francis Lee</td>
<td>member</td>
<td></td>
<td>admin</td>
</tr>
<tr>
<td>&quot;Paris device group members&quot;</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Pradesh Jones</td>
<td>admin</td>
<td></td>
<td>member</td>
</tr>
<tr>
<td>- Akiko Yamada</td>
<td>admin</td>
<td></td>
<td>member</td>
</tr>
</tbody>
</table>

If you want everyone in the user group to have administrator role for the device group or share, you only need one user group. Assigning device group administrator and share administrator roles does not enable other roles.
Your default user group

When you register devices remotely you assign your HPE Passport ID to those devices. When you sign in to Insight Online with that same ID, those devices appear in the main devices view in your Insight Online My IT Environment tab. These devices are in your default device group, which is created automatically.

At the same time, a default user group and default contract and warranty share are created, whose names have the same structure as the default device group (using HPE Passport profile first and last name):

<table>
<thead>
<tr>
<th>Default structure</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default device group</td>
<td>Marie Curie devices</td>
</tr>
<tr>
<td></td>
<td>See Your default device group for details.</td>
</tr>
<tr>
<td>Default user group</td>
<td>Marie Curie default user</td>
</tr>
<tr>
<td>Default contract and warranty share</td>
<td>Marie Curie devices (same as default device group name)</td>
</tr>
<tr>
<td></td>
<td>See Derived contracts and warranties for details.</td>
</tr>
</tbody>
</table>

You are the only user in your default user group, and you cannot modify it. If you want other users to access your device groups or shares, create a separate user group.

Delete a user group

As a user group administrator you can delete a user group. Exceptions:

- You cannot delete a user group if it is the only user group that is assigned the administrator role for a device group or a share.
- You cannot delete your own default user group.
Manage your devices, device groups and solutions

When you first sign in, the My IT Environment dashboard shows you an overview of your environment. Show all of your devices in the following ways:

**Option 1:** Click Devices on the dashboard.

**Option 2:** Click My IT Environment > Devices.

This takes you to the All devices view:
The All devices view

The All devices view is similar but not identical to a view of Your default device group. The All devices view is a mixed view, containing:

- Device groups shared with you by other users. These device groups may be top-level groups, child groups, or lowest-level groups, in the environment of the user who shared the group with you.
- Second-level (child) device groups you created.
- Individual devices registered using the direct connect method, whose registration must be completed.
- Individual devices in your default device group that you have not put into a child group.
- Individual devices that you have put into a child group, that you have not removed from your default device group.
- Solutions.

Hover your cursor over an object to display summary information. Click a summary to view details. For a device whose registration is complete, click the device to go to its individual screen.

To simplify what you see in the All devices view, you can create child device groups (see Create a device group), put devices into those child groups, then remove the devices from your default device group (using Manage device groups > Edit device groups and selecting your default device group). Then only groups, consisting of child groups and groups shared with you by other users, will appear in this view.

Types of objects displayed

The All devices view contains three types of object: device groups, solutions and devices:
These objects are displayed in the following order:

1. Device groups
2. Hosting devices (physical and virtual machines)
3. Solutions
4. Incompletely registered devices
5. Critical devices
6. Normal devices
7. Manually added devices

By default these are sorted by status. From the drop-down list you can:

Sort, by device:
- Name

Filter, by device:
- Type (critical, normal, non-remote)
- Problem (monitoring, collections)
- Registration issue (These devices cannot be monitored or analyzed. Contact your service partner or HPE to resolve.)
- Overdue communication

Devices

Devices can be remotely supported or manually added. Remotely supported devices typically have a management protocol such as SNMP or WBEM installed. Remotely supported devices include:

- Servers, storage systems, solutions and switches, registered for remote support using the central connect method. With central connect you register the device to communicate with HPE through an HPE Insight RS centralized Hosting Device in your local environment.
- ProLiant Gen8 and later servers registered for remote support using the direct connect method. This method is available using HPE iLO 4 Management Engine 1.40 or later, or Intelligent Provisioning 1.60 or later.
- BladeSystem c-Class enclosures registered for remote support using the direct connect method. This method is available using the Onboard Administrator (OA) 4.11 or later.

**Note:** To address third-party software vulnerabilities, HPE recommends using:
- iLO 4.2.03 or later
- OA 4.30 or later

To access the iLO or OA web interfaces, you must enable Transport Layer Security (TLS) in your browser. TLS is the successor to Secure Sockets Layer (SSL).

A manually added device is not registered but is added by you locally within Insight Online. See [Add a device manually](#) for details.

## Device states

Devices may be in different states:
- Incompletely registered (direct connect only)
- Remote health status displayed (direct connect only)
- Critical
- Normal
- Manually-added (so not remotely supported)

A device can be an Insight RS Hosting Device. An Insight RS Hosting Device may be a virtual machine or a physical server. In both cases the Insight RS Hosting Device:
- Appears in the device view as a normal device, named "Insight RS host"
- Can be added to child device groups
- Is part of the device count, both overall and within device groups

When the Insight RS Hosting Device is:
- A virtual machine, it is not included in counts of service events, remote support issues, cases, or contracts and warranties, and information about those features is not available. Its device type is listed as a type of virtual platform.
- A physical server, the device type and model of the physical server are displayed.

## Icons and text in individual devices

For individual devices, the view displays the following:
<table>
<thead>
<tr>
<th>Icon or text</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incomplete</td>
<td>A device was registered using the direct connect method, and its registration must be completed. Click the device to complete its registration. Devices with incomplete registration remain in your default device group, or in default device groups shared with you by other users. Once you or the user who has shared the device group with you has completed the registration you can move the device to a child group.</td>
</tr>
<tr>
<td>Orange exclamation point</td>
<td>Device has a remote support issue.</td>
</tr>
<tr>
<td>Green square with check</td>
<td>Device has normal service event status.</td>
</tr>
<tr>
<td>Red circle with X</td>
<td>Device has a critical service event.</td>
</tr>
<tr>
<td>Device name</td>
<td>Typically a name you entered when registering the device. Otherwise obtained automatically from the Windows “ComputerName” property, or through the AMS(^1), which is a lightweight service that collects OS-based information and provides it to iLO.</td>
</tr>
<tr>
<td>Device type/model</td>
<td>Example: HW / HPE Next Generation ProLiant DL380 server.</td>
</tr>
</tbody>
</table>

\(^1\)Agentless Management Service
Delete a device

From the Actions drop-down list on an individual device page, select the **Delete device** menu item:

The result of deleting a device from Insight Online depends on the type of device and connection method:

- You can delete manually added devices entirely.
- You cannot delete central connect devices in Insight Online. The menu option is available but disabled. To delete such a device, use the Insight RS console. Select the device in the Device Summary tab, then select **Actions > Delete selected**.
- You can delete direct connect devices, but note that this is not a true delete or unregister; it only removes the device from the Insight Online view of devices. To delete such a device, go to the device management user interface where the device was originally registered (ILO, Intelligent Provisioning, OA) and disable or delete the device there. Delete the device from Insight Online only as a last resort, and only if the device remains in the Insight Online view even after you have disabled or deleted the device as described.

See the [HPE Insight Remote Support and Insight Online Setup Guide for HPE ProLiant Servers and HPE BladeSystem c-Class Enclosures](#) for more information about deleting central connect and direct connect devices.

Refresh devices

Device groups shared with you, devices, device properties, and contract and warranty information may all be added, removed or modified outside Insight Online while you are signed in. Batch processes that finish can change device counts and the content of device listings. Click the refresh devices button in the upper right to bring Insight Online's view of these items up to date:

The effect is the same as signing out and signing in again.

Add a device manually

You can add devices manually in Insight Online, using **Add Devices**, but doing so does not register the devices for remote support.
This means that you do not see service events or configuration details for those devices. However, adding devices may still be useful since it allows you to view contract or warranty details for these devices, and allows you to see all your devices, whether remotely supported or not, in one place.

Devices are always associated with a contract or warranty, even if the contract or warranty has expired. Contracts and warranties associated with remote support devices are automatically linked to the HPE Passport ID registered for the device, and are visible in Insight Online. However adding a device in Insight Online manually requires that you first identify the contract or warranty that covers the device, and then link it to your HPE Passport ID.

If the device you want to add is not listed in the contracts and warranties that are linked to your HPE Passport ID, you must find a contract or warranty that covers the device, add it, and link to it. See Link contracts and warranties for more information.

Manually added devices display a gray icon in the device view (on the right, below), that indicates the device is not registered for remote support:

**Devices with expired contracts or warranties**

Devices whose contract or warranty has expired are still displayed in the devices view, with “Support Expired” displayed:
If support coverage for a device has expired, contact your HPE Services sales representative or HPE Authorized Channel Partner to purchase continued support coverage.

Claim an HPE storage device

Browse to My IT Environment > Devices > Claim an HPE storage device to claim an HPE storage device.

Claiming allows you to complete Insight Online remote support registration by assigning ownership of a storage device that previously had no ownership set.

Unlike devices that you add manually, device status, service events, support cases, and associated contracts and warranties will be listed for devices you claim.

To claim a device, provide:

- Product serial number
- Product number
- Service Agreement ID (SAID)
- Support Account reference (SAR)

You have three attempts to enter these values correctly before being locked out for one minute.

Upon successful claiming of a device, a refresh occurs and the device will appear in your device list. You can then click on the device to review and if necessary update the partner, optimization opt in, and support contact information for the device.

Device groups

A device group is a container that you create or that another user has shared with you. You can perform the following tasks:

- Hover your cursor over a device group to see summary information such as totals for critical service events, devices with remote support issues, cases, and expired contracts and warranties.
• Click a summary to view details.
• Click a device group to see devices and child device groups within it.

Your default device group

When you first sign in, Insight Online creates a default device group named according to the information you provided in your HPE Passport account profile, in the form:

first name + last name + "Devices"

For example, Marie Curie's default device group is:

Marie Curie Devices

Each user has only one default device group. Your default device group contains:

• Devices recognized as being associated with your HPE Passport ID, registered through either central or direct connect methods, that you have not moved into a child device group.
• Devices you add manually that you have not put into a child device group.
• Child device groups you create.

Every device group is associated with a user group. You are the only user in the user group associated with your default device group, and you cannot add users to it. To give other users the administrator role, or any other role, for your default device group, create another user group or use an existing user group, assign roles to it, and associate it with your default device group. To do so, click on Manage device groups then Edit device group in the Actions drop-down list at the far right, and follow the procedure.

Your default device group does not appear by name in the All devices view, because the view is displaying (among other things, as listed above), the contents of your default device group. To see your default device group, click on Manage device groups in the Devices submenu:
From there you perform such functions as adding and removing devices, adding and deleting child device groups, and updating the contract and warranty status of the devices in the group.

**Note:** If you have purchased a new contract that covers a device, or the ownership type of an existing contract associated with a device changes, use Run contract and warranty update to update the association. See "Run contract and warranty update" on page 48 for details.

In the All devices view, you cannot distinguish child groups created by you from groups shared with you by others:

![Devices](image)

Look at Manage device groups when you need to make this distinction. In Manage device groups, child groups created by you appear under your default device group. They are indented:

<table>
<thead>
<tr>
<th>Device groups</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DP12.1_UATUser1 Devices</td>
<td>Created by the system to manage devices.</td>
</tr>
<tr>
<td>child group second level</td>
<td></td>
</tr>
<tr>
<td>child group third level</td>
<td></td>
</tr>
</tbody>
</table>

Groups shared with you by other users on the other hand appear in Manage device groups at the same level as your default device group. That is, they appear at the top level, not indented:
This does not necessarily mean they are top-level groups in the environment of the user who shared them with you. A group shared with you could be a child (second level) or bottom (third level) group in the environment of the original user, and it will still appear at the same level as your default device group. If another user shares two or three levels of groups with you, the topmost shared group appears at the same level as your default device group.

Sharing a device group does not share its child groups. Child groups must be explicitly shared to make them visible and accessible. This means that if another user shares a device group with you but not its child groups, you will not be able to see child groups under that device group, even if you are an administrator. This can cause side effects such as in device and group counts, and in a possible inability to delete a device group. If that happens contact the other administrators of the device group you are trying to delete. The administrators are listed in Manage Device groups in the Device group administrators column.

**Note:** You can rename any device group, but you should be careful about renaming your default device group, especially in a complex environment with many users and shared device groups, because the name is the only indication that it is your default device group.

### Create a device group

Device groups let you arrange your devices into logical groupings to make managing your environment easier. Put devices that you want to manage in the same way, or that have something in common, into a group.

Device groups you create in Insight Online are child device groups, typically within your default device group. The default device group is created when you first sign in, and is associated with a default user group containing only yourself.

You can create two levels of device groups. Your default device group can contain child device groups (second level) which can in turn contain child device groups (third and lowest level). Create second- and third-level child groups as a way to organize large numbers of devices into categories.

When you create a child device group, you must associate it with at least one user group. Your own HPE Passport ID is in the default user group, which is always listed, so you can add that first, and add other user groups later. In this way you can construct a meaningful set of child device groups, and add user groups to them afterwards.
All devices associated with your HPE Passport ID are in your default device group to begin with. Devices must be in at least one device group, and can be in more than one device group. For example, you can create a child device group based on function, such as servers, and another child device group based on location, such as Houston, and put the same devices into both groups. You can associate each device group with a different user group.

Devices that you put into a child device group remain in your default device group unless you remove them. After you put devices into child groups, you can then remove them from your default device group (using Manage device groups > Edit device groups and selecting your default device group), to simplify what you see in the top-level All devices view.

If you have more than 60 devices in a device group, HPE recommends that you move the devices into child groups. This is just a guideline, to make the management of your devices easier and improve the performance of the device page.

When other users share device groups with you, you see those groups in your All devices view.

To create new child device group, complete the following steps:

- Click Manage device groups in the Devices submenu.
- Click Create new child device group in the Actions drop-down list at the far right of your default device group, or of a second-level child device group:

Then follow the four-step procedure:
1. Provide a group name and description and add devices:

Click **Next**.

2. Verify the derived contracts and warranties associated with the device group. Click **Next**.

3. Associate a group of users with the device group. You can create a new user group or select an existing user group. Click **Next**.

4. Assign feature service roles to the members of the user group. (See “Assign roles to user groups” on page 17.) Click **Next**.

Insight Online creates a derived contract and warranty share (described in Share contracts and warranties) automatically when you create a device group.

**Device group roles**

When you create a device group, you must assign the roles of administrator and member to at least one associated user group.

You are the device administrator of any device group you create. You can edit a device group that you have created or that has been shared with you as an administrator. Administrators and members can perform different actions:

**Device group administrator and member actions**

<table>
<thead>
<tr>
<th>Action</th>
<th>Admin</th>
<th>Member</th>
</tr>
</thead>
<tbody>
<tr>
<td>Can add and remove devices</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Can add and remove associated user groups</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Can modify roles assigned to associated user groups</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Can delete the device group</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Can create child device groups</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Can view device information</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Can view contracts associated with the device group</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>
In addition to administrator and member, you assign other roles to each user group to enable feature access. See “Assign roles to user groups” on page 17 for details.

Delete a device group

Click **Delete device group** in the Actions drop-down list in the row containing the device group, in Manage device groups:

Note that it is possible for a device group to contain child groups that you cannot see, if they have not been shared with you. For example:

- You have shared a device group with another user and that user has created a child group within that group and not shared it with you.
- Another user has shared a device group with you and that user has created a child group within the shared group and not shared it with you. (Sharing a group does not automatically share child groups within it.)

In these scenarios you will not be able to delete the device group. You must contact the other administrators of the device group. Though you cannot see an unshared child group or know exactly who the creator is, the creator will be one of the administrators of the device group, since only an administrator could have created a child group. The email addresses of the administrators are listed in Manage Device groups in the **Device group administrators** column. Contact the administrators in the list to find out which of them created the child group, and ask the creator to share the child group with you or to delete it.

Each device group displays the following:

**Icons and text in device groups**

<table>
<thead>
<tr>
<th>Icon or text</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group name</td>
<td>User defined. If the name is truncated, hover over the name to see the complete version.</td>
</tr>
</tbody>
</table>
**Icons and text in device groups, continued**

<table>
<thead>
<tr>
<th>Icon or text</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red circle</td>
<td>Devices in the device group with critical service event status.</td>
</tr>
<tr>
<td>Green square</td>
<td>Devices in the device group with normal service event status.</td>
</tr>
<tr>
<td>Orange exclamation point</td>
<td>One or more of the devices in the group has a remote support issue. Hover over the device group to see the number.</td>
</tr>
<tr>
<td>Device total</td>
<td>Number of devices in the device group.</td>
</tr>
<tr>
<td>Group total</td>
<td>Number of child groups in the device group. For device groups shared with you, this total only includes the number of child groups within that have been shared with you. (Sharing a device group does not automatically share child groups within it.)</td>
</tr>
</tbody>
</table>

**Solutions**

A *solution* is a collection of devices configured together for a specific business purpose. Solutions are created and managed in Insight RS and are read-only in Insight Online. In Insight Online, solutions have characteristics of both devices and device groups. The differences can be seen in two contexts, "solution as container", and "solution as device", explained below.

**Solution as container**

A solution behaves like a device group, in that it contains devices, and its details screen lists totals for the devices it contains. In Insight RS, the devices in the container are the components you add to a solution.

1. In the All devices view, click a solution:

   ![Solution](image)

   The resulting screen displays the devices in the solution, similar to a device group:
2. Click **View details** to view solution details, similar to a device group details screen:

![Solution Details Screen](image)

You can also reach the solution details by hovering over the solution in the All devices view to reveal **View details**: 

![Hover Details](image)
Solution as device

In the All devices view, a solution looks like a device. The solution is associated with a particular device, which you specify in Insight RS when creating the solution, using the following fields:

- Name
- Type
- Serial number
- Product number
- Product model
- Custom delivery ID

In the All devices view, view the details of the solution as device as follows:

1. Click a solution. The resulting screen displays the devices in the solution, similar to a device group. In addition, the device associated with the solution itself is listed first, on its own row.
2. Click the device in the first row to view the details of the device:

The device details are similar to those of any other device:
## Configuration

No image provided for this device.

Remote connection type: Insight RS Centralized Connect
Version: 7.3.0.0042

HPE Insight Remote Support
Hosting Device: Unknown

### Service events

<table>
<thead>
<tr>
<th>Type</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Critical</td>
<td>0</td>
</tr>
<tr>
<td>Cases</td>
<td>0</td>
</tr>
<tr>
<td>New</td>
<td>0</td>
</tr>
<tr>
<td>In progress</td>
<td>0</td>
</tr>
</tbody>
</table>

### Contracts & warranties

<table>
<thead>
<tr>
<th>Type</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contracts &amp; warranties</td>
<td>1</td>
</tr>
<tr>
<td>Expired</td>
<td>1</td>
</tr>
<tr>
<td>Expiring within 30 days</td>
<td>0</td>
</tr>
<tr>
<td>Expiring within 31 days to 1 year</td>
<td>0</td>
</tr>
</tbody>
</table>

[Submit case]
Contracts and warranties

For some HPE Support Center features, you must have an active contract or warranty covering a specific product to access HPE's downloads, knowledge, and tools. You gain this access when you link your HPE Support Center profile to your contract or warranty. Your profile can be linked to a contract or warranty in three ways:

- You link your HPE Support Center profile to a support agreement, packaged support, or warranty.
- Another user has linked their HPE Support Center profile to a support agreement, packaged support, or warranty, and has created a contract and warranty share that includes you as a member.
- You connect remote support devices to Insight Online and the contracts or warranties for those devices are automatically linked for you.

Note: Contracts and warranties are managed through the HPE Support Agreement Manager website. To reach the site, click My IT Environment > Contracts & warranties > HPE Support Agreement Manager.

Link contracts and warranties

You can link three types of contracts and warranties. Expand the section below section for the type of contract or warranty you want to link. If you have a large number of contracts and warranties to link, HPE recommends you use the "Batch link tool" on page 42.

Link support agreements

Gather the following information before you begin:

<table>
<thead>
<tr>
<th>Required information</th>
<th>Where to find</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Agreement ID</td>
<td>• In the support documentation.</td>
</tr>
<tr>
<td></td>
<td>• On the Electronic Support Contract Assistant website.</td>
</tr>
<tr>
<td>Support Account Reference (SAR)</td>
<td>• In the customer cover letter that describes the contract or warranty.</td>
</tr>
<tr>
<td>(also known as System handle)</td>
<td></td>
</tr>
</tbody>
</table>

If you do not have your contract IDs, click the Request a copy of your Service Contract Welcome Letter link at the top of the page.

For a video demonstration of linking support agreements, see: media.now.hpe.com/mp.aspx?key=MNKKJSL.DEL&eid=LSNNPRMDFG

To link support agreements, complete the following steps:

1. Browse to Contracts & Warranties:
   - **Option 1:** main menu > My contracts and warranties, then click Link support agreements.
   - **Option 2:** My IT Environment > Contracts & warranties > Link support agreements.
   - **Option 3:** On the HPE Support Center homepage, click Contracts and Warranties, then click Link support agreements.
2. Choose whether to display your email. Select "Yes" to share this information, or "No" to keep it private.
   Choosing "Yes" simplifies the management of your entitled services by allowing other users to see your name and email address if they link or attempt to link a contract or warranty you own. For details, see "Display your user name and email" on page 49.

3. Enter your Service Agreement ID (SAID).

4. Enter your Support Account Reference (SAR).

5. Choose an ownership type. If you link a contract or warranty yourself, you are the initial owner. As owner you decide the ownership type: single or multiple. This choice affects the ability of other users to link to the contract or warranty.
   - Single—Use this mode to be the only user who can link to the entitlement with full privileges and control. You can still share it to one or more other users, so they receive some or all the privileges.
   - Multiple—Use this mode when you are in an organization where support for contracts is done by a group. In this mode other users can link to the entitlement with full privileges; all are equal owners, therefore, creating shares is unnecessary.

6. Repeat steps 3 through 5 for all of your support agreements. Click Add more support agreements to add up to 20 links. If you need to add more than 20 links, consider using the "Batch link tool" on page 42.

7. Click Submit.

If you receive an error message stating that the contract or warranty is already linked to someone else, contact that owner to gain access rights. This may be the result of the owner selecting single ownership when creating the link and not creating a share with a user group that includes you. The owner may not be revealed if the owner has not shared his or her contact information, so you may have to find the contract administrator on your site to identify the owner. Once identified the owner has these options to grant you access:
   - Change the ownership type for that contract or warranty from single to multiple.
   - Add you to a user group associated with a share containing that contract or warranty.
   - Add you to a user group associated with a device group that includes a device covered by that contract or warranty.

**Link packaged support**

Gather the following information before you begin:

<table>
<thead>
<tr>
<th>Required information</th>
<th>Where to find</th>
</tr>
</thead>
</table>
| Packaged support ID  | • In the support documentation.  
                        | • On the Electronic Support Contract Assistant website. |
| Product number       | • In the support documentation.  
                        | • In the customer cover letter that describes the contract or warranty.  
                        | Note these are the product number(s) of the products covered by the packaged support. |
| Product location     | This is the country where the product was purchased. |

If you do not have your contract IDs, click the Request a copy of your Service Contract Welcome Letter link at the top of the page.
For a video demonstration of linking packaged support, see:
media.now.hpe.com/mp.aspx?key=MNKKJSLDEL&eid=OKSRLSDGDE

To link packaged support, complete the following steps:

1. Browse to Contracts & Warranties:
   - **Option 1:** main menu > My contracts and warranties, then click Link packaged support.
   - **Option 2:** My IT Environment > Contracts & warranties > Link packaged support.
   - **Option 3:** On the HPE Support Center homepage, click Contracts and Warranties, then click Link packaged support.

2. Choose whether to display your email. Select "Yes" to share this information, or "No" to keep it private.
   Choosing "Yes" simplifies the management of your entitled services by allowing other users to see your name and email address if they link or attempt to link a contract or warranty you own. For details, see "Display your user name and email" on page 49.

3. Enter your Packaged support ID (SAID).

4. Enter your Product number.

5. Enter your Product location.

6. Enter an optional product nickname.

7. Choose an ownership type. If you link a contract or warranty yourself, you are the initial owner. As owner you decide the ownership type: single or multiple. This choice affects the ability of other users to link to the contract or warranty.
   - **Single**—Use this mode to be the only user who can link to the entitlement with full privileges and control. You can still share it to one or more other users, so they receive some or all the privileges.
   - **Multiple**—Use this mode when you are in an organization where support for contracts is done by a group. In this mode other users can link to the entitlement with full privileges; all are equal owners, therefore, creating shares is unnecessary.

8. Repeat steps 3 through 7 for all of your packaged support. Click Add more support agreements to add up to 20 links. If you need to add more than 20 links, consider using the "Batch link tool" on page 42.

9. Click Submit.

If you receive an error message stating that the contract or warranty is already linked to someone else, contact that owner to gain access rights. This may be the result of the owner selecting single ownership when creating the link and not creating a share with a user group that includes you. The owner may not be revealed if the owner has not shared his or her contact information, so you may have to find the contract administrator on your site to identify the owner. Once identified the owner has these options to grant you access:

- Change the ownership type for that contract or warranty from single to multiple.
- Add you to a user group associated with a share containing that contract or warranty.
- Add you to a user group associated with a device group that includes a device covered by that contract or warranty.

**Link warranties**

Gather the following information before you begin:
### Required information

<table>
<thead>
<tr>
<th>Required information</th>
<th>Where to find</th>
</tr>
</thead>
</table>
| Product serial number | • In the product itself.  
                     | • In the support documentation.  
                     | • In the customer cover letter that describes the contract or warranty. |
| Product number        | • In the product itself.  
                     | • In the support documentation. |
| Product location      | Note these are the product number(s) of the products covered by the packaged support.  
                     | This is the country where the product was purchased. |

For a video demonstration of linking warranties, see:  

To link warranties, complete the following steps:

1. Browse to Contracts & Warranties:
   - **Option 1**: main menu > **My contracts and warranties**, then click **Link warranties**.
   - **Option 2**: My IT Environment > **Contracts & warranties** > **Link warranties**.
   - **Option 3**: On the HPE Support Center homepage, click **Contracts and Warranties**, then click **Link warranties**.

2. Choose whether to display your email. Select "Yes" to share this information, or "No" to keep it private.
   - Choosing "Yes" simplifies the management of your entitled services by allowing other users to see your name and email address if they link or attempt to link a contract or warranty you own. For details, see "Display your user name and email" on page 49.

3. Enter your Product serial number.
4. Enter your Product number.
5. Enter your Product location.
6. Enter an optional product nickname.
7. Choose an ownership type. If you link a contract or warranty yourself, you are the initial owner. As owner you decide the ownership type: **single or multiple**. This choice affects the ability of other users to link to the contract or warranty.
   - **Single**—Use this mode to be the only user who can link to the entitlement with full privileges and control. You can still share it to one or more other users, so they receive some or all the privileges.
   - **Multiple**—Use this mode when you are in an organization where support for contracts is done by a group. In this mode other users can link to the entitlement with full privileges; all are equal owners, therefore, creating shares is unnecessary.
8. Repeat steps 3 through 7 for all of your warranties. Click **Add more support agreements** to add up to 20 links. If you need to add more than 20 links, consider using the "Batch link tool" on the next page.
9. Click **Submit**.

If you receive an error message stating that the contract or warranty is already linked to someone else, contact that owner to gain access rights. This may be the result of the owner selecting single ownership when creating the link and not creating a share with a user group that includes you. The owner may not be revealed if the owner has not shared his or
her contact information, so you may have to find the contract administrator on your site to identify the owner. Once identified the owner has these options to grant you access:

- Change the ownership type for that contract or warranty from single to multiple.
- Add you to a user group associated with a share containing that contract or warranty.
- Add you to a user group associated with a device group that includes a device covered by that contract or warranty.

**Batch link tool**

The Batch link tool allows you to link up to 12500 contracts and warranties to your profile at a time.

You can upload five files containing 2500 contracts each. If you have more than 12500, you can resubmit as many times as you need to, until all of your contracts and warranties are linked to your account.

The CSV file must have an extension of .csv and meet the following maximum requirements:

- **Name length**: 50 characters.
- **Size**: 5 MB
- **Number of lines**: 2500

For a video demonstration of the batch link tool, see:

media.now.hpe.com/mp.aspx?key=MNKKJSLDEL&eid=QMNOMMHJDK

To link contracts and warranties using the batch link tool, complete the following steps:

1. **Browse to** My IT Environment > Contracts & warranties > Batch link tool.
2. **Follow the steps listed on the upload page:**
   a. Download the latest Microsoft Excel template file from the link in Step 1. The format of the template name is "name-date_version", where the date is represented as YYYY-MM-DD.
   b. Read the detailed instructions in the Readme sheet of the template.
   c. Enter information, one contract or warranty per line, according to the titles at the top of each column. Enter a maximum of 2500 lines, for each instance of the template you create. Note that some of the fields are optional. For details, see "CSV file field values" on the next page.
      
      If you do not have your contract IDs, click the Request a copy of your Service Contract Welcome Letter link at the top of the Batch link tool page.
   d. Do a "Save as", to comma-separated value (CSV) format. (Select CSV (Comma delimited) (*.csv) option only from "Save as type" in Excel.) The result is a plain text file containing the entries from the spreadsheet, with each field on each line separated by a comma.
3. **Optionally, update whether to display your email.** Select "Yes" to share this information, or "No" to keep it private.
   
   Choosing "Yes" simplifies the management of your entitled services by allowing other users to see your name and email address if they link or attempt to link a contract or warranty you own. For details, see "Display your user name and email" on page 49.
4. **Check the boxes to verify that you have selected the most recent template, and that you have a CSV file.**
5. **Browse to the CSV file on your local computer, then click Upload.**
6. After you upload the CSV file, a popup window appears. Click **Close**. An initial file check occurs verifying that the file size is within limits and has the correct file extension. If this file check succeeds, the batch upload summary page displays. This page lists the upload date and status, and a link to a report file, for each CSV file you have uploaded. Click on a report file link to view the report, which contains details about the upload. You can also save the report file. The default sort for the list is by date. Click on the Status or Report file headings to sort by those fields instead.

Status values for each uploaded batch file in the list are as follows:

- **Completed**.
- **Completed with errors**. See the report file for details.
- **Invalid file format**. The file was not recognized as a valid CSV file.
- **File exceeds limit**. The file was longer than 2500 lines or greater than 5 MB.
- **Pending**. Files that have been received and have not completed processing. A maximum of two uploads can be pending.
- **System error**. The file itself may be fine. Try uploading again later.

**CSV file field values**

The CSV field values are the same as the columns in the Excel spreadsheet. The CSV file requires different fields for different contract and warranty types, called "Obligation type" in the Excel spreadsheet. See the table below for the required fields for each obligation type.
### Derived contracts and warranties

When you sign into HPE Support Center, devices that you remotely registered to Insight Online, and their associated contracts and warranties, are visible to you. In your list of contract and warranty shares, some are derived by Insight Online. Derived means that Insight Online determines the contracts and warranties that are associated with a group of remotely registered devices, and automatically creates a contract and warranty share containing those contracts and warranties. This occurs for:

---

1 The product number of the product covered by the Packaged support or by the warranty.

2 You can add a nickname for packaged support or warranty. Service agreements have predefined nicknames, added at the time of signing the contract.

Normally you export from the downloaded template and "save as", and do not need to edit or even look at the CSV file. There may be cases however, such as if an invalid file format error occurs and you suspect that the file may be corrupt, where it is useful to inspect the file.

The following is a valid sample line for a warranty from a CSV file. In this example, double commas surround the third field, SAR, which is empty because a warranty does not need a SAR:

```
XY08K33099,SP936UC,,Warranty,France,SINGLE,WarrantyNickName1
```

Each line should contain at least six commas. Additional commas at the end of the line, which may occur if any text, even a space, was in the seventh column of the template file you exported from, are ignored.

Report files list the processing result of each line including entries that were not able to be processed, typically for the following reasons:

- A support agreement was inactive or was in single ownership mode.
- A warranty was inactive or was migrated to uplifted packaged support.
- Packaged support was inactive, was in single ownership mode, or was uplifted to a Support Agreement.

You should address these cases individually, by reactivating or by changing the ownership mode to multiple. Once you have done so you can then resubmit a file containing these entries for batch processing, or depending on their number, simply link them interactively.
Your default device group. (Your default contract and warranty share)

A child device group you create.

A device group of which you are an administrator.

Derived contract and warranty shares are marked by a red asterisk. The name of the contract and warranty share is the same as the name of the corresponding device group. You can view the details of these derived contract and warranty shares but unlike a contract and warranty share that you create yourself, you cannot edit or delete them:

![Image](image-url)

However, you can update the derived contract and warranty share from Manage device groups in the device group area, by selecting Run contract and warranty update in the Actions drop-down list of the corresponding device group. See Run contract and warranty update for details.

**Share contracts and warranties**

You can share contracts and warranties that are linked to your profile by creating a contract and warranty share or a child device group.

You are linked to the contract through a contract and warranty share created by an owner. Privileges are limited by the roles assigned to the user group you are in, that the owner associated with the share.

You can also be linked to a contract indirectly through a device group that has a) an associated user group that includes you as a member, and b) contains a device covered by the contract or warranty.

If a contract is shared with you, either directly through a share or indirectly through a device group, you can access the features available in the contract, as long as access to those features is enabled for the user group you are in. See Assign roles to user groups in the online help for details.

Certain actions are available only to owners, and only to contracts that were not derived. Only owners can:

- Transfer ownership
- Change the ownership type
- Change the nickname

You can view details for contracts and warranties shared with you by either method in View my contracts & warranties:
Create a contract and warranty share

Create a contract and warranty share as follows:

1. Browse to My IT Environment > Contracts & warranties > Manage contract & warranty shares, then click Create new share.
2. Name the share and add contracts and warranties.
3. Associate user groups to the share.
4. Assign roles to the user groups.
One of the user groups you added in Step 3 must be assigned the role of share administrator, because at least one user group must have that role. Select the **administrator** check box. You can change this later, as long as one user group has administrator role.

To add user groups with the role of member, you do not need to check any boxes, since the member role is the default.

Share administrators and members can perform different actions:

**Contract and warranty share administrator and member actions**

<table>
<thead>
<tr>
<th>Action</th>
<th>Admin</th>
<th>Member</th>
</tr>
</thead>
<tbody>
<tr>
<td>Can add to and remove contracts from the share</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Can view contracts in the share</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Can add and remove user groups associated with the share</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Can change the roles of the user groups associated with the share</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Can view administrators of the share</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Can view members of the share</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Can transfer ownership of the share</td>
<td>x</td>
<td></td>
</tr>
</tbody>
</table>
Create a child device group

When you create a child device group, the contracts and warranties associated with those devices are shared with users in the user group(s) you associate with the device group. These users can perform certain actions, depending on:

- The features allowed by the contracts and warranties associated with the devices in the device group.
- The roles you enabled when you created the device group. See Assign roles to user groups in the online help for details.

See Create a child device group in the online help for the procedure.

Run contract and warranty update

Run contract and warranty update modifies the association of contracts with devices in a device group. This action is in Manage device groups, in the Actions drop-down list of a device group, if you are an administrator of the device group:

(Contracts and warranties are referred to as "contracts", and remotely supported devices are "devices" below, for brevity.)

Run the update any time after the original automatic registration and entitlement process was completed, when:

- You have purchased a new contract that applies to at least one of your devices, and you have linked that contract to your profile.
- Another user has shared one or more contracts with you, that apply to at least one of your devices.
- 1.) Another user has changed the ownership type of a contract that applies to at least one of your devices from single to multiple, allowing you to link that contract to your profile.
- 2.) You have then linked that contract to your profile.

The result of running this update is that contracts that you have linked will be visible from the details page of both the device group and of the individual device(s) covered by the contract.
Display your user name and email

You can simplify the management of your contracts and warranties by allowing other users to see your user name and email address.

1. Browse to Contracts & Warranties:
   - **Option 1**: main menu > My contracts and warranties.
   - **Option 2**: My IT Environment > Contracts & warranties.
   - **Option 3**: On the HPE Support Center homepage, click Contracts and Warranties.

2. Select "Yes" to share this information, or "No" to keep it private.

Choosing "Yes" simplifies the management of your entitled services by allowing other users to see your profile and email address if they link or attempt to link a contract or warranty you own.

![Display your user name and e-mail](image)

Choosing "Yes" will allow other HPE Support Center users to see your user name and e-mail address if they link or attempt to link a support agreement, packaged support or warranty you own.

The result of this action depends on the ownership type of each contract or warranty:

<table>
<thead>
<tr>
<th>Button value</th>
<th>Result</th>
<th>Multiple ownership</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single ownership</td>
<td>If another user tries to link to that same contract or warranty, that user is directed to contact:</td>
<td>Visibility of your information, from any other user who also links as a multiple owner to that same contract or warranty:</td>
</tr>
<tr>
<td>Yes</td>
<td>You, via email, for access.</td>
<td>visible</td>
</tr>
<tr>
<td>No</td>
<td>Their contract or warranty administrator.</td>
<td>hidden</td>
</tr>
</tbody>
</table>

You can view and change this setting at any time. Regardless of the selection you make, if you are the single owner of a contract or warranty and you create a share including it, the users in the associated user group will be able to see your information as well as the information of the other users in that user group. In other words visibility among users within a share takes precedence over this setting.

Transfer ownership

You can transfer ownership of your linked contracts and warranties to another registered HPE Support Center user. This action is only available to owners, and only to contracts and warranties that were not derived. This actions is not available to you if the contract or warranty was shared with you.
The result of this action depends on the ownership type:

<table>
<thead>
<tr>
<th>Ownership type</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single</td>
<td>You transfer ownership to a different user with a valid profile, by entering that user's email address. Your account is unlinked from the contract or warranty. The contract or warranty will be removed from any share you own.</td>
</tr>
<tr>
<td>Multiple</td>
<td>You replace your link to the contract or warranty with a link to another user's account. Links to the contract or warranty from other users are not affected.</td>
</tr>
</tbody>
</table>

1. Browse to [My IT Environment > Contracts & warranties > Transfer ownership](#).
2. Specify the new owner by entering their email address or by selecting it from the list. Click Add.
3. Click Next.
4. Select the contracts and warranties you want to transfer.
5. Click Submit.

### Unlink contracts and warranties

If you want to remove the association of the contract or warranty with your profile you can unlink the contract or warranty.

If a contract or warranty you are linked to with single ownership is also part of a share, consider transferring ownership before unlinking it from your account. If you do not, the share will be removed as well, and those users will lose their access to the services provided by that contract or warranty.

To unlink contracts and warranties, complete the following steps:

1. Browse to Contracts & Warranties: [My IT Environment > Contracts & warranties > Unlink contracts & warranties](#).
2. Unlink single or multiple items at one time by checking the box below the "Unlink" column.
3. Click Submit.

### Reports

If you purchase the HPE Proactive Care service, you receive reports about your environment. These reports are generated on a regular basis and automatically appear on the Reports page.

To view reports, your devices must be connected to HPE using one of the HPE remote support technologies. You receive reports only for the HPE Proactive Care Service Agreement IDs (SAIDs) that are linked to your HPE Support Center profile. See [Proactive Care Central](#) for more information.

HPE Authorized Channel Partners can also view reports containing information about their customers' devices. Customers must associate your partner location ID with each device.

Click the Reports icon on any page in the My IT Environment or in My Customers:
The following reports are available:

<table>
<thead>
<tr>
<th>Report</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident</td>
<td>Detailed information about all incidents, incident trends, and parts usage for devices covered by your HPE Proactive Care contract to help avoid repeat problems. Generated quarterly.</td>
</tr>
<tr>
<td>Proactive Scan</td>
<td>Information about HPE Proactive Care supported devices connected to HPE. Provides a technical device assessment that helps identify potential system configuration problems before they impact your business operations. Generated twice a year.</td>
</tr>
<tr>
<td>Firmware and Software Version</td>
<td>Recommendations for applicable software versions, patches, and firmware revisions for each covered device connected to HPE. Generated twice a year.</td>
</tr>
</tbody>
</table>

**Message log**

The message log is a list of messages about remotely supported devices that are registered to your HPE Passport ID or that are in device groups shared with you:

- Monitoring
- Registration and connection problems
- Overdue communications
Status of batch processes submitted for completion of device registration

The update of service information

Access the message log from the submenu in various locations. The messages that display depend on where you access the log:

<table>
<thead>
<tr>
<th>Area</th>
<th>Messages shown for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dashboard</td>
<td>All devices</td>
</tr>
<tr>
<td>All devices view</td>
<td>All devices</td>
</tr>
<tr>
<td>Device group page</td>
<td>Devices in the device group</td>
</tr>
<tr>
<td>Individual device page</td>
<td>Individual device</td>
</tr>
</tbody>
</table>

Each message in the log contains fields for time generated, message type, identifier (device name) and description.

By default the listing is sorted by Coordinated Universal Time (UTC) generated, not converted to the time zone specified in your profile. Click the column heads to sort by those fields. Select a message type from the View drop-down list at the top to display messages of a particular type. Click the description field to display the individual message, or hover over the field to see the first 290 characters of the description.

In an individual message, click the device name to go to the overview for that device.

Messages are for remotely supported devices only, not manually added devices.
Service Credits

The Service Credits feature provides access to:

- Service Credits purchased on HPE support agreements.
- The HPE services exchanged for those credits.
- Additional HPE services available for exchange of Service Credits.
- For authorized users, the ability to purchase HPE services using a shopping cart.

To access Service Credits, you must have a proactive services support agreement associated with your HPE Passport profile.

To reach Service Credits, browse to the My IT Environment homepage, either from the main menu or the HPE Support Center homepage. On the My IT Environment page, click My IT Environment > Service Credits.

The Service Credits home page provides a summary:

Click on any of the items in the sub-menu to see detailed information:
You can print the displayed results from any page.

Service Credits administrator and member roles

- Administrators will see a shopping cart in the upper right of the Service Credits pages, and can use Shop HPE services to purchase more services by adding them to the cart.
- Members can view My Service Credits and My services, and access featured HPE services.

Administrator and member roles exist in the context of a contract and warranty share. To access Service Credits, the contract and warranty share must contain at least one service support agreement, and include a user group that includes you as a member, with the administrator or member role enabled for Service Credits. This is the same mechanism used for granting access to other features of the HPE Support Center. See "Assign roles to user groups" on page 17 for more information.

The items in the Service Credits sub-menu are as follows:

My Service Credits

This page displays Service Credits against all your active and expired support agreements. These agreements are either linked to your HPE Passport ID directly, or through a device group or contract and warranty share that was shared with you by another user who enabled the Service Credits role. Support agreements that expired within the past two years are included.

The displayed list shows Service Credits by Support agreement, which can include a Service Agreement ID (SAID) or a Support Account Reference (SAR). If you have no currently active Service Credits, you can use the View filter to see expired or all Service Credits instead. You can filter by status or search using the drop-down and search box at the top. Click an
SAID or SAR to go to a page showing the details of the specific agreement in the Contracts & Warranties area. Click an individual Service Credit item to see details. Sort the results by any column by clicking on the column head.

**My services**

The **My services** page displays HPE services purchased using Service Credits from active and expired support agreements. These agreements are either linked to your HPE Passport ID or shared with you by another user. Support agreements that expired within the past two years are included.

By default, the list is sorted by status. Filter the results by status using the **View** drop-down list. Sort the results by any column by clicking on the column head.

Click a service activity name in the list to go to the service overview page in **Shop HPE services**.

Click **View details** to show the detailed status for the service activity. On the **My service details** page, click on the contextual help icon next to the service name to see a brief description of the service.

For each order listed under the service, use the Actions drop-down list at the far right of the row for additional options available for that service. Note that the options vary depending on the service, the status of the service, and your role. Options can include:

- **E-mail HPE**. Use this form to request that an HPE services representative contact you to discuss your business needs. The representative will contact you within three business days of submitting the request. Provide details and contact information in the form.

- **Schedule service**. Schedule and unschedule services in the list using the Actions drop-down list at the far right. After you make the change, the status and dates for that service will be updated in the list.

- **Reschedule service**. Change the date of the service. When rescheduling, HPE will review the request within three business days and either confirm or will email you proposing an alternate date and time.

- **Remove scheduled date**. Revert a service to the unscheduled status.

- **Cancel service**. If you cancel a service, the Service Credits associated with that service are refunded to the support agreement that has the furthest expiration date, up to what it contributed to the original order. Cancellation information is appended to the original order in **My orders**. Service Credits cannot be refunded to a support agreement where those Service Credits have since expired. Note you cannot cancel a service credit if the credit has been used or is expired.

**My orders**

The **My orders** page displays your orders purchased using Service Credits. The list displays the service activity within the order, as well as other details. You can filter the list, sort it by column head, and search for orders. Use the Actions drop-down list on the far right of each row to view details. If you are an administrator, the list includes a link to reorder services. Click an order in the list to see order details.
Shop HPE services

Service Credits administrators can click on any of the service category links on the right of the Service Credits homepage, or on Shop HPE services in the Actions drop-down list, to reach Shop HPE services:

You can choose a variety of HPE services from the list. Filter the list using the category and subcategory drop-down lists, and sort the results by category, subcategory and service activity. You can also search for HPE services using the search text box.

Click a service activity in the list to see an overview. This displays a price, in Service Credits, for the service, and boxes for you to enter the quantity of the service, to add to your cart. Some activities have prerequisites. If so, click the Prerequisites tab, and purchase them in the same way.

If you have support agreements spanning more than one country you will be asked, only once, to specify the country for the HPE service. Select the country from the drop-down list.

The cart may indicate that you need to make changes to your services. If so make the necessary changes then proceed. Before submitting your order you can review the order and specify which Service Credits you want to use. By default the checkout process assigns Service Credits to pay for cart contents by expiration date, with those scheduled to expire first being used first. You can change this before submitting the order, by using the Service Credits to use field in the right column.

Review the information, check the box indicating you have understood and accepted the scope of the services as described, and submit. When checkout completes successfully, an order number is displayed, and confirmation is emailed to you.

View the current contents of the cart at any time by clicking the cart.

<table>
<thead>
<tr>
<th>Category</th>
<th>Subcategory</th>
<th>Service activity</th>
<th>Price in Service Credits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom</td>
<td>Custom</td>
<td>Custom Deliverable - Account Support Manager</td>
<td>During standard HPE business hours: Upon request, Upon request</td>
</tr>
<tr>
<td>Custom</td>
<td>Custom</td>
<td>Custom Deliverable - Technical Consultant</td>
<td>During standard HPE business hours: Upon request, Upon request</td>
</tr>
</tbody>
</table>

**HPE Insight Online: User Guide**
You can request a custom service activity. Provide details of your request, your contact information, the support agreement containing the Service Credits you wish to use, and submit the form. An HPE representative will contact you within three business days.

You can also provide feedback using the feedback form.

**Support cases**

Support cases are associated with devices and with your HPE Support Center profile. Within My IT Environment you can view and modify cases.

In the HPE Support Center you can browse to Cases in the following ways:

- **Option 1**: main menu > **My IT Environment**, then **My IT Environment** > **Cases**.
- **Option 2**: On the HPE Support Center homepage, click **My IT Dashboard**, then **My IT Environment** > **Cases**.

Note that you can also create, view and modify cases in the Support Case Manager.

**View support cases**

Within My IT Environment, you can view your support cases from several places:

<table>
<thead>
<tr>
<th>Click on Cases here:</th>
<th>To reach a list of support cases associated with:</th>
</tr>
</thead>
<tbody>
<tr>
<td>My IT Environment dashboard</td>
<td>All devices you own or that are shared with you.</td>
</tr>
<tr>
<td>My IT Environment main drop-down</td>
<td>All devices in the device group.</td>
</tr>
<tr>
<td>A device group's details page</td>
<td>The device.</td>
</tr>
<tr>
<td>A device's details page</td>
<td></td>
</tr>
</tbody>
</table>

On the Cases page, filter the case list using combinations of status, content type and search type as follows:

<table>
<thead>
<tr>
<th>Status</th>
<th>Content type</th>
<th>Search type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Case title</td>
<td>Contains</td>
</tr>
<tr>
<td>New</td>
<td>Case ID</td>
<td>Starts with</td>
</tr>
<tr>
<td>In progress</td>
<td>Serial number</td>
<td>Ends with</td>
</tr>
<tr>
<td>Closed</td>
<td>Product number</td>
<td>Equals</td>
</tr>
<tr>
<td>Any</td>
<td>and</td>
<td></td>
</tr>
</tbody>
</table>

For example, search for an active case ID that equals 123456789:
To filter by status only, select a status, leave the search box empty, and click **Search**.

Active status includes new and in progress cases.

You can sort the cases in the list, in ascending or descending order, by clicking on any of the headings in the list.

You may not be able to view the details of a listed case. In that case a page appears requesting a product number, serial number, or Service Agreement ID to view the case details.

Once closed, case histories are available for 30 days. If you have contractual reporting services, contact your account delivery team. HPE recommends that you manage reporting on a monthly basis.

### View a case details page

To view case details, complete the following steps:

1. Browse to the Cases page using one of the methods described in "View support cases" on the previous page.
2. Click a case ID in the list to reach the case details page, which is part of the HPE Support Center Support Case Manager. A case details page lists the following:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case ID</td>
<td>Assigned when the case is first submitted.</td>
</tr>
<tr>
<td>Case title</td>
<td>Provided when the case is submitted.</td>
</tr>
<tr>
<td>HPE Support Contract</td>
<td>The HPE support agreement covering the system.</td>
</tr>
<tr>
<td>Source</td>
<td>Where the case was submitted from:</td>
</tr>
<tr>
<td></td>
<td>* Web: SCM</td>
</tr>
<tr>
<td></td>
<td>* Other channels: telephone or other medium</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Type</td>
<td>The case type, hardware or software related.</td>
</tr>
<tr>
<td>Case Status</td>
<td>• Received by HPE: received and is currently being routed to a support agent.</td>
</tr>
<tr>
<td></td>
<td>• In Progress: a support agent has been assigned to this case and is working on it.</td>
</tr>
<tr>
<td></td>
<td>• Completed.</td>
</tr>
<tr>
<td>Submitted</td>
<td>The date each case was initially received by HPE.</td>
</tr>
<tr>
<td>Customer Tracking Number</td>
<td>Use this number to co-relate this case to your own tracking application. Optional.</td>
</tr>
<tr>
<td>Schedule and Parts Information</td>
<td>HPE's schedule to complete the repair, and the parts required to address the problem.</td>
</tr>
</tbody>
</table>

3. Below the case information are two tabs:
   - Case details & history. Click this tab to add attachments or request to close the case.
   - Service and parts. Click this tab to view on-site service and parts order details.

   The On-site service section displays subcases by ID, and lists:
   - Description
   - Service status
   - Expected service date
   - Completed service date

   The Parts order section displays subcases by ID, and lists:
   - Part number
   - Part description
   - Order status
   - Expected delivery date
   - Actual delivery date
   - Carrier
   - Tracking number

4. Click on a subcase ID to view details about the subcase. Only support agents can update subcases.
Update a case

You can add comments and attachments to open cases, and close cases.

Note that you can also update cases in the Support Case Manager.

To update a case, complete the following steps:

1. Browse to the Cases page using one of the methods described in “View support cases” on page 57.
2. On the Case details & history tab, click **Update, add attachment or request to close this case.**
3. Update the following:

   - **Add comments**
     
     In the text box, add comments and click **Update.** On submission your comments are added to the case history and the support agent is informed.

   - **Email attachments**
     
     Email pertinent documents such as program files, log files and illustrations to open cases by using the email link on the case details or case submit confirmation pages. Do not modify the email subject line. The attachments are added to the case and the support agent is notified. You will receive a confirmation email when they are processed. You cannot access documents attached to a case through Support Case Manager.
     
     For security reasons, send the email from the same domain address as the domain of the case contact's email address, if possible. (The domain is after the @. For example: @mycompany.com.) Email delivery time is not guaranteed.

   - **Close a case**
     
     In the text box, enter a brief explanation of why you want to close the case, and click **Update.** Cases are not automatically closed as the result of a request. A support agent closes the case after reviewing the request.

Submit a case

To submit a case, use the Support Case Manager (SCM). For details, see the Support Case Manager topic in the HPE Support Center Help.
Service events

View and manage service events for devices monitored by HPE remote support. Access Service events from two places:

The Insight Online menu:

<table>
<thead>
<tr>
<th>Insight Online</th>
<th>Insight Online</th>
</tr>
</thead>
<tbody>
<tr>
<td>My IT Environment</td>
<td>My Customers</td>
</tr>
</tbody>
</table>

- Dashboard
- Devices
- Service events
- Cases

The Insight Online dashboard:

When a device monitored by HPE remote support submits an issue, a service event is generated and automatically reported to you through Insight Online. Additional analysis may be performed at HPE, and a support case will be opened if an intervention is needed. The service event may be closed when no action is currently required. If a support case has been created from this service event you can see the corresponding case number in the service event list page. The service event remains in an active state until the service is delivered and the corresponding support case is closed.

You must be a member of a user group that has the Service events role enabled to view service events.

View service events

Select Service Events from the main drop-down list. The fields in the service event list are as follows:

- Severity: red = critical
- Device Name. Click to see device details. Hover to display service event and contract & warranty status.
- Date/Time Generated.
- Problem Area.
- Problem Description. Click to see service event details. Hover to see a brief problem description.
- Case ID. Displayed if there is a support case associated with the event. To see the case you must be in a user group that has the Support Case Manager (SCM) role enabled, and is associated with the device either through a contact and warranty share that covers the device, or a device group that contains the device.
- Status: Active or Closed. Transitional event status values of Open, Submitted, Received, Entitled and Closed Pending Confirmation are defined as "Active" events.

Click on the Refresh button (labeled "Devices") on the right above the list to see the most current status of service events.

**Sort and filter service events list**

By default, active service events are listed, by severity and date/time submitted. You can sort service events by any field except Case ID, by clicking on the field name at the top of the list.

Select an option in the View drop-down list to filter the service events:

<table>
<thead>
<tr>
<th>Filter</th>
<th>Service events displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Currently active and being processed. (Default.)</td>
</tr>
<tr>
<td>Critical</td>
<td>Currently critical and active.</td>
</tr>
<tr>
<td>Closed</td>
<td>Have been closed because a) they did not require any intervention and no case ID was created or b) the service was delivered.</td>
</tr>
<tr>
<td>Test events</td>
<td>Those that test the end-to-end flow between the device and HPE.</td>
</tr>
<tr>
<td>All</td>
<td>All events regardless of status. The first 1000 devices are displayed.</td>
</tr>
</tbody>
</table>
Search service events

Use Basic Search to search service events by problem description.

Use Advanced Search to search service events by any field and to filter the results.

Service events details (individual device)

In the list of service events, click on the problem description of an individual device to reach the details page for that event:

![Service events details](image)

The details page displays the problem area, description, entitlement status and recommended action when applicable. The page may also include links to Customer Self Repair (CSR) documentation and videos.

To print from a details page, select Print page in the Actions drop-down list (the small blue icon on the far right).
My document repository

My document repository provides you, as an authorized customer, access to documents that service agents are sharing with key contacts within your company. The document repository is a cloud-based software solution provided by iManage Share that is designed to help your business securely store and access information for better collaboration. Customers with the service level of Proactive Care Advanced or higher are eligible to have a document repository created for their company by their HPE account team.

If you have received an invitation to activate your iManage Share account you should do so, by setting up a password according to the invitation. Once you have done this, when you are signed in to HPE Support Center, you can click the My document repository link to go directly to your document folder.

If you have not activated this account, the link is still active but you will not be able to sign in.

Note that iManage Share performs maintenance every other Saturday 12 AM - 3 AM US Eastern time, during which access to your documents may be limited.
My Customers

HPE Authorized Channel Partners can view and manage customer devices by using the Insight Online My Customers tab.

**Note:** When using Insight Online, each HPE Passport ID can support a maximum of 1,500 devices.

This tab is only visible to those who are recognized as a partner at sign in. If HPE Support Center recognizes you as a channel partner, you can reach My Customers in the following ways:

- **Option 1:** main menu > **My Customers**.
- **Option 2:** If you are already in Insight Online and want to return to the dashboard, click the **My Customers** tab.

There are two types of HPE Authorized Channel Partner:

- **HPE Authorized Reseller.** To become an HPE Authorized Reseller, a company must apply to become a partner on the Partner Portal and meet certain criteria. Once approved, HPE will assign the company a partner location ID. Individuals at the partner company can register to become users of the partner portal. During registration, users create an HPE Passport ID that is linked to their company's location ID. The same HPE Passport ID is used to sign in to Insight Online. Insight Online will identify you as an Authorized Reseller.

- **HPE Authorized Service Partner.** Upon reaching a level of HPE sales, HPE offers your company, as an HPE Authorized Reseller, training to deliver break-fix service as a ServiceOne partner. If this is of interest, your company can become accredited as an HPE Authorized Service Partner. Once HPE accredits your company, Insight Online automatically identifies you as an HPE Authorized Service Partner at sign in.

**Note:** For brevity, 'channel partner', 'reseller' and 'service partner' are used in this document for the above terms.

If a customer does not assign a channel partner, service delivery defaults to HPE. As a channel partner, you have the option to have Insight RS cases automatically routed to you.

Enable access to customer’s device information

As a channel partner, you must share your partner location ID with your customers and ask them to associate it with the devices they want you to manage. To allow you to view configuration information for their devices, you must also ask them to optimize their IT environment.

For central connect devices, customers should use the Insight RS Hosting Device setup wizard:

- On the **Receiving Remote Support** screen, check "Consent to have HPE or my HPE Authorized Channel Partner contact me to discuss optimizing my IT environment". Checking this option will affect all devices managed by Insight RS. Only you as a channel partner will be able to receive configuration information, and not HPE. HPE will not contact your customers if you are the registered partner in Insight RS and Insight Online.

- On the **Authorized Channel Partners** screen, click the Partner ID option and enter the partner location ID.

For direct connect devices, customers should use Insight Online. The information can be added in one of three places:
At Step 3 of the device registration sequence. See Complete direct connect device registration for one or more devices.

After registration, using Edit service information.

For an individual device, from the Edit link on the Configuration tab of the device's details page.

Enter the partner location ID.

Choose Optimize my IT environment setting. Note that for direct connect devices this action only applies to the specific devices you select.

By checking the box labeled I consent to having HPE or my HPE Authorized Reseller/Distributor contact me to discuss optimizing my IT environment you agree to allow HPE or your HPE Authorized Reseller/Distributor to access your collected configuration information and contact you with recommendations to purchase additional hardware and software products to optimize your IT environment. These providers may be located in other countries than your HPE IT hardware location(s). HPE Authorized Resellers/Distributors are required to keep information received from HPE confidential and may use it only for the purpose of providing advisories and recommendations on behalf of HPE.

To withdraw your consent, clear the box labeled I consent to having HPE or my HPE Authorized Reseller/Distributor contact me to discuss optimizing my IT environment.

Note: Only the HPE Authorized Resellers/Distributors and Authorized Service Partners you associate with your devices can receive your configuration data to individually contact you to make IT environment...
This setting can be updated at any time. See “My Customers” on page 65.

The All customers view

For you as a channel partner, the **My IT Environment** tab and the **My Customers** tabs are active. The My Customers menu has links to these sites:

- Partner portal contains partner information about Insight Online and Insight RS.
- CSN is a virtual, global community made up of HPE customers, HPE service channel partners and HPE.

Customers do not see **My Customers**. Its top-level content contains customer objects, rather than devices and device groups:
My Customers

Welcome to HPE Insight Online for Partners! Experience personalized access to the information you need to sell to and support your customers. Understand the features and benefits or find out how to get started.

### All customers

<table>
<thead>
<tr>
<th>HPE</th>
<th>9 Devices / 0 Groups</th>
<th>1. DevOps Enterprise Company</th>
<th>2. DevOps Enterprise Company</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0</td>
<td>1. DevOps Enterprise Company</td>
<td>2. DevOps Enterprise Company</td>
</tr>
<tr>
<td></td>
<td>9</td>
<td>7 Devices / 0 Groups</td>
<td>0 Devices / 0 Groups</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4</td>
<td>3</td>
</tr>
</tbody>
</table>
Click on a customer object to see the customer’s devices. As a channel partner you can only see those devices that have been associated by the customer with your partner location ID as described in Enabling access to customer’s device information. Some differences exist in this view, depending on the type of channel partner:

**Customer information available to HPE Channel Partners**

<table>
<thead>
<tr>
<th>Insight Online feature</th>
<th>HPE Authorized Reseller</th>
<th>HPE Authorized Service Partner</th>
<th>Customer opt in required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Devices and solutions:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Configuration details</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Service levels</td>
<td>•</td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Reports:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Device configuration</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Contracts and warranties</td>
<td>•</td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Support case</td>
<td></td>
<td></td>
<td>•</td>
</tr>
<tr>
<td>Service event</td>
<td></td>
<td></td>
<td>•</td>
</tr>
<tr>
<td>Firmware</td>
<td></td>
<td></td>
<td>•</td>
</tr>
<tr>
<td>Service events:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Details</td>
<td></td>
<td></td>
<td>•</td>
</tr>
<tr>
<td>Icons in dashboard</td>
<td></td>
<td></td>
<td>•</td>
</tr>
<tr>
<td>Link to CSN</td>
<td></td>
<td></td>
<td>•</td>
</tr>
</tbody>
</table>

For direct connect devices, the customer who owns the device can change the partner location ID at any time, either individually or by group. See Edit service information for details.

**Customer dashboard**

Within each customer object is a dashboard, accessible from the main drop-down list:
The dashboard contains areas for devices and Service events (service partners only), and links to Manage device groups and Delete customer group in the Actions drop-down list on the right:

**Favorite customers**

In the All customers view, you can designate a customer “favorite” by hovering over a customer object and clicking Add as favorite:
A star is then added to the customer object. Selecting at least one favorite customer activates the "Favorites only" filter on the right:

You can select a maximum of 25 favorites.

Initially, all customers are displayed by default. Click on "Favorites only" to display favorite customers, and "All customers" to change back. This choice remains your default customer view until you change it.

The View filters and the Search action will apply to the set of customers you are viewing--either all customers or favorites only.

You can hover over a favorite customer object and remove it from your favorites. If you remove all favorites, the "Favorites only" filter is deactivated.

**Remove customer groups from the view**

As a partner you may need to remove a customer group from your All customers view if there are no longer devices associated with this customer. Duplicate customer groups may be created over time, or your relationship with the customer may have changed. Since a customer group is like a device group, removing a customer group is like removing a device group. You remove the customer group from Manage device groups. To remove a customer group, two conditions must be met:

1. No devices must appear in the customer group. To achieve this, the customer must do one or more of the following, depending on the kind of devices in their environment:
   - Disable the connection to Insight Online from the Insight RS console (Administrator Settings > Insight Online tab) that contains the devices managed by the partner.
• Or, delete all central connect devices from the Insight RS instance that contains the devices managed by the partner.

• Remove all direct connect devices from the Insight Online My IT Environment by using the Insight RS console (preferred), or by using the Insight Online Delete device function.

• Or, change the partner location ID for all devices managed by the partner. The partner location ID of direct connect devices can be changed in Insight Online using Edit service information (see Edit service information), and of central connect devices in the Insight RS console in the Company Information > Channel partners screen.

2. Child device groups that you, or any other partner administrator, have created within the customer group must be removed. Child groups created by the customer do not matter, since you as a partner do not see them.

Once there are no devices and no child groups remaining in the customer group, you can remove the customer group as follows:

1. From the All customers view, click on the customer group.

2. Select Dashboard from the main menu.

3. From the dashboard, click the Actions drop-down list on the right, then click Delete customer group:

   ![TS Support R&D usability](image)

   It is possible for another partner administrator with access to the same customer group to create a child device group within it. If that child group is not shared with you, you will not be able to delete the customer group. You must contact the other administrators of the customer group. Though you cannot see an unshared child device group or know exactly who the creator is, the creator will be one of the administrators of the customer group you are trying to delete, since only an administrator could have created the child device group. You can see who these administrators are in Manage Device groups in the Device group administrators column. Contact the administrators in the list to find out which of them created the child group, and ask the creator to share the child group with you or to delete it.

## Service events

To see service events associated with customer devices that are monitored by HPE remote support, the customer must assign you as the HPE authorized service partner when they register the devices either through Insight RS, or for direct connect devices, in Insight Online when they complete registration for those devices.

You can reach the list of service events three ways, from the All customers or Favorite customers view:

• Hover your cursor over a customer object to view a summary of that customer’s service events. Click critical service events in the display to view the corresponding events.

• Hover over a customer object and click the View details button. This takes you to the dashboard for that customer. Select service events from the main menu.

• Click a customer object to go to a page listing the remote support devices belonging to that customer. Select Service events from the menu.
See “Service events” on page 61 for more information.

**Service levels**

Channel partners can use the Service levels feature to view information about the highest service level (such as an HPE warranty, support agreement or packaged support) available that applies to each device that is monitored by HPE remote support.

From the details screen of a device, click the **Service levels** area on the right. The service levels details screen displays. Check the "Include all active service levels" to show both the highest service level (packaged support, for example) and other applicable service levels as well (a warranty, for example).
Profile and settings

After you sign in, click the icon in the upper right of any page:

Profile
Change your:
- E-mail address
- Name
- Preferred language
- Country or region of residence
- Contact preferences
- User ID
- Password
- Security questions

Provide:
- Additional business or personal contact information

Delete:
- Your profile

Settings
View and edit the following:
- Your profile
- Forums settings
- Subscriber's Choice profile
- Support case manager
View the following:

- Contracts and warranties
- Entitled content access

The Settings page displays a summary of your current access to entitled HPE Support Center features and content:

<table>
<thead>
<tr>
<th>My HPE Support Center Access</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>HPESC Role:</strong> Customer</td>
</tr>
<tr>
<td><strong>Feature access:</strong></td>
</tr>
<tr>
<td>All public, and the following entitled features</td>
</tr>
<tr>
<td>Patch management</td>
</tr>
<tr>
<td>Diagnostic passwords</td>
</tr>
<tr>
<td>Software updates &amp; licensing</td>
</tr>
<tr>
<td>Support case manager</td>
</tr>
<tr>
<td><strong>Content access:</strong></td>
</tr>
<tr>
<td>All public, and the following entitled downloads and content</td>
</tr>
<tr>
<td>HP ProLiant DL Servers - Recovery</td>
</tr>
<tr>
<td>Storage Networking - Firmware</td>
</tr>
<tr>
<td>Storage Networking - Management Software</td>
</tr>
<tr>
<td>Storage Networking - Recovery</td>
</tr>
<tr>
<td>Storage Networking - Software</td>
</tr>
</tbody>
</table>

**Gain access to entitled features and content**

- Link warranties
- Link packaged support
- Link support agreements
- Learn more about content access at HPE

You have access to these if your HPE Passport ID is associated with an active support agreement, packaged support, or warranty (all referred to as "contract", below), by one or more of the following means:

- You are linked as the owner, in single mode, to a contract that enables access.
- You are linked in multiple mode to a contract that enables access.
- You are a member of a user group associated with a contract and warranty share, that includes a contract that enables access.
- You are a member of a user group associated with a device group, that contains a device that is covered by a contract that enables access.

The summary also displays your current role in HPE Support Center (for example customer, partner, employee).
In the summary, follow the links under **Gain access to entitled features and content** to link your HPE Passport ID to additional entitlements. See **More Information on Access to HPE Support Materials** or click **Learn more** in the summary for additional information.

**Sign out**

Sign out of this HPE Support Center session.

**Language and country selector**

See “The language and country selector” on page 77.
The language and country selector

The language that HPE Support Center displays in, and country-specific contact information such as in "Contact HPE", are by default determined by the country you are accessing the site from. For example, if you are in Italy, the site appears in Italian, and the contact information is local to Italy.

You can change this language and country setting at any time by clicking the globe icon in your settings:

Several countries share languages, but the country-specific information is different. Ecuador and Mexico for example, share Spanish, but the contact information for each is different.

Some languages differ slightly depending on region. The Spanish associated with countries in South America, for example, is different from the Spanish associated with Spain, and the Portuguese associated with Brazil is different from that of Portugal.

The complete list of supported languages is as follows:

- Chinese (simplified)
- Chinese (traditional)
- English
- French
- German
- Italian
- Japanese
- Korean
- Portuguese
- Russian
- Spanish

Technical documentation also appears in search results, if available, in the selected language.
You can use this feature to compare languages, if for example you are not sure of terminology in a given language. You can open a link in a new window, change the language in that window, and compare the different language versions of the same content.

Once you change a language in one window, the language will change for subsequent links on the site in all open windows, and will remain your selected language even after you sign out and back in again. To return to your original language, select it from the language and country selector.
Support resources

Find the following items in the Help menu:

- Site help (this help) to find procedures and how-to information about HPE Support Center features.
- Site support to request assistance or report issues with specific HPE Support Center features.
- Contact HPE to find sales and support contact information.

Find the following items in the main menu:

- Chat with HPE to help you find solutions to common product issues.
- Forums, an online community for peer-to-peer technical support and knowledge sharing. Like-minded professionals gather to exchange knowledge, best practices, and experience.
- Submit or manage support cases.

After you use the search to identify your product, on the product page the following options appear, if available:

- Sign up for alerts to receive alerts about your HPE products.
- Customer Self Repair to request replacement parts that you can install yourself. Note CSR is only available for certain products.
- Chat with HPE.

For worldwide technical support information, see the HPE support website. Before contacting HPE, collect the following information:

- Product model names and numbers
- Technical support registration number (if applicable)
- Product serial numbers
- Error messages
- Operating system type and revision level
- Detailed questions

HPE Support Center documentation

Find HPE Support Center and Insight Remote Support documentation at the Hewlett Packard Enterprise Information Library.
Glossary

A

Agentless Management Service (AMS)
iLO 4 AMS uses out-of-band communication for increased security and stability. This feature runs on iLO hardware which is independent of operating system and processor.

C

contract
General term including: HPE support agreement, packaged support, and warranty.

contract and warranty
General term including: HPE support agreement, packaged support, and warranty.

CSN
Channel Services Network

Customer Self Repair (CSR)
A feature in the Product Support section of HPE Support Center. Allows HPE to ship replacement parts directly to you, and provides you with the option of replacing parts yourself or having it done by HPE service personnel. Available for certain products.

D

Derived contract or warranty
A contract or warranty that is automatically linked to your HPE Passport ID as a result of being associated with a device registered to you or shared with you by another user.

device
Any object such as a server, storage system, or switch, that by means of being monitored by HPE remote support technologies and properly registered, or added manually, appears in Insight Online.

E

entitlement
The process of authorizing a request for support based on the contents of warranty or support contracts held by the customer, normally with respect to a specific Object of Service (OOS) such as a hardware or software component. Your level of entitlement is determined by your HPE Support contract. Contact your HPE Account Team for more details.

H

HPE Authorized Channel Partner
Two types: HPE Authorized Reseller, who has been approved by HPE to become a partner in the Global Partner Portal, and who meets certain criteria. HPE Authorized Service Partner, who in addition to the services a reseller can provide, can also deliver break-fix services.

HPE Authorized Reseller/Distributor
Channel partners who sell hardware and services.

HPE Authorized Service Partner
Channel partners who deliver services and/or installation service on HPE’s behalf.

HPE Insight Online
Part of HPE Support Center. Provides secure access to support the devices in your IT environment. Used primarily by IT staff and HPE Authorized Channel Partners to support infrastructure.

HPE Insight Remote Support
Insight RS provides proactive remote monitoring, diagnostics, and troubleshooting to help improve the availability of supported HPE servers and storage systems in your data center.

HPE Passport ID
ID for your HPE Passport account. Needed to sign in to HPE Support Center and Insight Online. It may be the email address you used when registering.
**HPE Support Center**
Contains: Product Support and My IT Environment sections. Use Product Support to find drivers, patches and other software, and search for a variety of support documentation. Use Insight Online to manage your remote support devices and contracts, and to access features such as Service Credits and reports. HPE Authorized Channel Partners also have access to a My Customers section.

**iLO**
Integrated Lights-Out. Embedded server management technology that delivers web-based remote management that is always available.

**OA**
Onboard Administrator. The OA for BladeSystem enclosures provides both local and remote administration of BladeSystem c-Class enclosures.

**opt-in**
During or after device registration, the customer consents or "opts-in" to have HPE or a partner contact them to discuss optimizing their environment.

**Packaged support Services**
An enhanced support package that can be purchased for many HPE products and services. These services extend coverage when an original warranty expires. They reduce downtime risks with support levels from basic to mission-critical.

**Secure Sockets Layer (SSL)**
Standard security technology for establishing an encrypted link between a web server and a browser.

This link ensures that all data passed between the web server and browsers remain private and integral.

**Service Agreement ID (SAID)**
A Service Agreement ID (SAID) is your unique support identifier with Hewlett Packard Enterprise.

**service event**
HPE remote support technologies monitor a customer's hardware environment for service events that require action from the HPE Authorized Service Partner or customer. For the most part, actionable service events require replacing a failed Field Replaceable Unit or Customer Replaceable Unit in the monitored hardware.

**Simple Network Management Protocol (SNMP)**
One of the management protocols supported by Insight Remote Support. Used extensively by networking systems and most servers.

**Support Account Reference (SAR)**
A type of product identifier. Also known as a System handle.

**Support Case Manager (SCM)**
A feature in the Product Support area of HPE Support Center. Use SCM to request support from HPE for products under active warranty.

**System handle**
Another name for Support Account Reference (SAR)

**Transport Layer Security (TLS)**
A protocol that ensures privacy between communicating applications and their users on the Internet. When a server and client communicate, TLS ensures that no third party may eavesdrop or tamper with any message. TLS is the successor to the Secure Sockets Layer (SSL).
Web-Based Enterprise Management (WBEM)
A set of management and Internet standard technologies developed to unify the management of distributed computing environments, facilitating the exchange of data across otherwise disparate technologies and platforms.
Index

C
channel partner
  customer info available 69
  edit service information (customer) 11
  favorites 70
  remove customer 71
  service levels 73
  servicevents 72
complete device registration 8
contracts and warranties
  batch link tool 42
  derived 44
  link 38
  share by creating contract and warranty share 45-46
  share by creating device group 48
  transfer ownership 49
  unlink 50
customer dashboard 69

D
default structures
  contract and warranty share 45
  device group 28
  user group 19
device
  all devices view 21
  organize 21
  simplify 21
  types of objects 21
central connect method 8
claim HP storage 27
complete registration 8
delete 25
direct connect method 8
edit service information 11
enable access by partner 65
expired contract or warranty 26
manually add 25
types of 21
device group 27
  create 30
  default device group 28
icons, meaning 33
roles 32

L
languages
  supported 77

M
message log 51
My Customers 50
My document repository 64
My IT Environment 50

O
optimize your IT environment 9

R
reports
  My Customers environment 50
  My IT environment 50

S
service credits 53
  admin and member roles 54
  my orders 55
  my service credits 54
  my services 55
  shop HP services 56
  shopping cart 54
solutions 34
support cases 57
  submit new 60
  view 57
supported languages 77

U
user groups 14
  create 14
  default 19
  delete 19
  roles assigned group-wide 18